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Introduction
Thank you for reading this manual!
Thank you for downloading the HD24tools software. This software was designed to help
users of the Alesis ADAT HD24 recorder perform daily tasks that were previously difficult
or impossible to achieve.
The support of the HD24 community has been of great help in developing this software. As
we are actively seeking to continuously improve this software. you are encouraged to contact
the author about any ideas for improvements you may have.
As the stream of response to the software has been increasing at a steady rate, the author has
put together these pages to help everyone get the information they need. By reading this
manual before asking questions, you help the author earn time to crack the really tough
ones! Should you have read this reference and still have questions, feel free to email the
author, so that this manual may be improved.
Hopefully the software and this manual help you get the most out of your Alesis HD24
recorder.
Sincerely,
Marc Brevoort

Disclaimer: The author is not affiliated with or supported by Alesis.

About the HD24tools software
The HD24tools software was developed to fulfill the need of transferring audio data from
FST disks to Linuxbased workstations. After fulfilling this need, the software has been
extended with some additional features, and ported over to various other operating systems,
platforms and architectures. As a result, the HD24tools software will allow you to transfer
your audio over almost any connection to almost any computer running almost any operating
system.

Key features of the HD24tools software
The HD24tools software consists of two main programs; one is HD24connect, the other is
HD24hexview. Normal users will probably mostly use HD24connect, which is the program
that allows transferring audio from HD24 ADAT FST disks. Key features of HD24connect
are:

●
●

●
●

Allows transferring audio to computers whether they run Linux, Windows or MacOS
Allows using the original Alesis FirePort 1394, as well as lowcost alternatives such
as external USB brackets
Automatic splitting of very large files into smaller pieces during transfer
In the case of disaster, allows safe, readonly data recovery, allowing DoItYourself
data recovery without requiring any knowledge of the FST file system

●

Permits audio transfers between locate points

●

Advanced transport control allows fast audio previews

●

●

Permits streaming audio directly from FST disk to audio applications (Currently for
Linux only)
100% safe readonly operation

The other program, HD24hexview, is a hex editor. It has the following features:

●

Directly displaying the ondisk data, permitting fast navigation of large disks with
minimal memory requirements;

●

Block selection

●

Write block to file

●

Checksum calculation

●

Sector access relative to endofdisk

●

Readonly mode (default) and expert mode to help prevent accidents

Finally, some features are part of the core engine and shared by both programs:

●

Automatic detection of HD24 ADAT FST disks

●

Allowing to force using nonFST or corrupt disks

●

Permitting the use of image files and alternate headers

●

Permits using any method of hooking up your drives to the computer

Additionally, the software supports most features that you have come to expect from the
official software: Multidisk support, free space preview, support for both FST version 1.00
and 1.10, 99 projects, 99 songs, exporting to various file formats, and so on.

Before using the software
Important: The software is provided free of charge in the hope that it will be useful, but is
provided AS IS with ABSOLUTELY NO WARRANTY, express or implied. The author can
not be held liable for any damage that may arise directly or indirectly from the software.
Please also take in account the regular disclaimers that apply for the operational conditions
for your hardware That is, do not attempt to hotswap a drive that is not hotswappable, do
not use in overly moist conditions, switch off devices before hooking them up, and so on.
Consult your hardware manual
A considerable amount of time time was spent to develop the software. If you use and like
the software and wish to support it, please consider making a donation to the author. Spread
the news. Please do not host the software on other sites you can always download the latest
version from the following page:
http://ringbreak.dnd.utwente.nl/~mrjb/hd24tools/download.html

Choosing your hardware
As HD24tools software works with a variety of hardware, you may want to take a moment
to pick the hardware that suits you best.

●

●

●

●

The Alesis Fireport is a safe bet under most circumstances: It will work on any
computer with a firewire interface, and allows hotpluggable operation. Additionally,
if you require writing from computer to HD24 ADAT FST disk, you will be able to
use the FST/Connect software enclosed with the fireport to do so.
If you do not want to get any additional hardware before performing a test drive of
the HD24tools software, you will be able to connect your FST drive directly to the
IDE interface of your computer. You will need to be aware of the master/slave
settings of the hard drive jumper. DO NOT DO THIS if you are uncomfortable
swapping around drives.
If you do not mind swapping drives from HD24 caddies to an external USB bracket,
almost any external USB case will do.
The original Alesis HD24 drive caddies were designed by a company called
ViPowER, Inc. If you wish to be able to plug in HD24 caddies directly to your PC,
consider using one of the compatible products that they have manufactured.
Depending on your needs, you could use either of the following (and possibly others):

●

ViPowER SuperRack model VP10KFU133
This is an internally mountable drive bay which connects directly to your IDE
interface. Fast but NOT hotswappable. Requires the ADAT drive to be the
only drive on the interface. This drive bay is incompatible with Alesis'
FST/Connect software, should you

●

ViPowER SwapRack VP1028LSF
An internally mountable drive bay which connects to an external USB
interface. Hotswappable. Requires an available USB port.

●

Others
Compatibility of HD24tools with other ViPowER hardware is likely but
unconfirmed.

Alesis' FST/Connect fireport software only supports FireWire drives. It will not work with
USB drive bays.

System recommendations
The HD24tools software should be able to run on almost any system with almost any
specification. Most likely, it will work on yours. To find out if it does, give it a try. Should
you find that it doesn't, please contact the author so that we can consider making HD24tools
work on your system as well.
Requirements for running the software:
–
–

–

Sufficient drive space to hold the audio files to be transferred;
Windows 2000 or Windows XP or MacOS X 10.3 or 10.4 (powerPC) or Ubuntu Linux
(other distributions may work as well);
Sound card (for audio previews)

Precautions
When connecting or disconnecting a HD24 ADAT FST drive, always take into
consideration the precautions that apply for your hardware (switching off devices before
swapping drives, etc).

Installing HD24tools
At the moment that this manual is being written, a graphical installer is not yet available for
HD24tools. However, the installation procedure should be relatively simple under most
circumstances.
First of all, check if you are running the last version of the software. If you aren't, this may
be a good time to download the last version of the software from the distribution website:
http://ringbreak.dnd.utwente.nl/~mrjb/hd24tools/download.html
Make sure that you grab the version for your operating system and platform. If you are
planning to use the software for any recovery work, make sure to also download the header
files (longliverec and unquickformat).
On Windows, you should copy the DLL files that come with HD24tools in your search
path. Normally c:\windows\system32 is a good place for this. The .exe files can then
be run from anywhere.
On a PowerPC with MacOS 10.4 it is recommended to use the .dmg package installer.
When installing on Linux or other versions of MacOS, you should copy the dynamic
libraries (portaudio, libsndfile) included in the .tgz file to the /usr/local/lib
directory on your system. You can do this via terminal, or (on the Mac) with Finder, at your
convenience. You may need to become root before you can perform the copy operation.
On Linux, drive detection will fail if the user does not have direct read access to the drive.
This can normally be solved by running as root (not recommended) or by altering your
/etc/fstab file to allow direct read access to common users. For instance, if your FST
drive is usually on /dev/hdc then your fstab entry may look as follows:
/dev/hdc

none

auto

devmode=0664

0

0

Normal operation
This chapter deals with normal operation of HD24connect. This means that in these
chapters, it is assumed that you start up HD24connect with a normal, valid HD24 ADAT
FST drive already connected to your system.

The main screen of HD24connect
The following is an example of what the main screen of HD24connect may look like just
after starting up, when a valid drive was found. The image may differ slightly depending on
the platform and operating system that you are running.

As you can see, the screen has divisions for drive info, project info, song info and transfer
options. The bottom left of the screen shows transport controls. To get the most out of the
application, let's take a look at each of the screen areas.

Drive info
The Drive Info area is in the top part of the user interface. It looks as follows:

If you have multiple drives connected to your system at the same time, the Drive Name
dropdown box will allow you to switch between the detected drives. The Rename button will
allow you to rename the drive (inmemory only, as the current version of HD24connect is
readonly). The area shows the number of projects on disk, along with the file system
version that the drive was formatted with. The free space preview shows an estimate of the
amount of space that is available on disk, based on a given sample rate and number of tracks
that you can select with the dropdown menus next to it. By changing the number of tracks
and sample rate, the preview will be automatically adjusted to match.

Project info
The Project Info area is located below the Drive Info area. It shows a dropdown box which
will allow you to choose the project that you want to look at, along with the total number of
songs in the project.

By default, the last project accessed on the HD24 recorder will be displayed. The field
'Number of songs' displays the total number of songs that are recorded within the currently
selected project. As with the Drive Info area, the Project Info area contains a Rename button
which will allow you to change the Project Info (inmemory only, as the current version of
HD24connect is readonly).

Song info
The Song Info area is one of the most complex areas of HD24connect. It contains various
controls that are related to individual songs. By default, it will display the last song accessed
by the HD24 recorder. The information displayed includes the number of tracks, song
duration, sample rate, bit depth (usually 24 bit) and writeprotect status. Again, there is an
(inmemory) Rename button.

For consistency, HD24connect displays durations and time codes in the format
HOURS:MINUTES:SECONDS:1/100 SECONDS. This differs from the HD24 recorder
which displays HOURS:MINUTES:SECONDS:FRAMES (with a frame normally being
around 1/30 second). This can cause some difference in time display between the HD24
recorder and HD24connect.
In addition to these settings, the Song Info area shows the list of locate points that are
defined for the song. The usual 25 locate points that are defined by the HD24 recorder are
listed, as well as a virtual locate point END which is located just after the last sample of the
song.

Locate points can be set inmemory, and although they are never written to disk, it is
actually useful to be able to do this, because HD24connect allows us to transfer audio based
on these locate points. The Set... button next to the locate point list allows us to set the locate
point that is currently being selected. When this button is clicked, a dialog will popup. This
dialog will permit us to change the name of the locate point, but more importantly also the
time code before which the locate point is situated. The button above the subseconds allows
us to switch back and forth between hundreths of seconds, frames (30th seconds) and
samples, which permits us sample accurate wave export, should we wish to do so.

It should be noted that the locate points should be seen as being located between the
samples; locate point 0 is located just before sample number 0, whereas a locate point that
has a value of 1 (sample) is located just before sample 1 and just after sample 0. This notion
is important when we want to export data split up in several blocks without overlapping
samples: we should not do anything such as incrementing sample offsets to allow this.
The 'Go' button (next to the 'Set' button in the song area) will move the transport cusor/tape
head to the currently selected locate point. In combination with manually setting locate
points, this allows us sampleprecise jumps to anywhere within the song. It should be noted
that it is not possible to jump beyond the end of the song. For the 'Go' button to work, the
transport must have been previously activated.

Transfer area
The Transfer area permits you to select a directory for file export, as well as marking which
tracks should be exported. By default, all tracks are marked for export. If the song has less
than 24 tracks, only the amount of tracks allocated for the song are displayed.

The button Invert will toggle all tracks between selected and unselected. This is useful for
quickly switching between exporting all tracks and exporting no (or just a few) tracks.
Clicking the Set button in the transfer area pops up a dialog which will let us choose which
range to export.

We select this range by choosing two locate points. Regardless of its value, locate point
START is always located before the beginning of the song, whereas virtual locate point
END is always located after the end of the song. This means that selecting START and END
will always export the entire song. Should the locate points be in reverse order, the export
will also take place backwards.
Before performing an export, we may still choose in what format we wish to export by
selecting the desired format in the Format dropdown box. Currently supported are 24bit
mono WAV files and 24bit mono AIFF files. Although these formats should be readable by
most systems, some software programs have trouble reading 24bit PCM. In that case, the
exported data will mostly sound like loud noise. This can be resolved by finding a CODEC
that supports 24 bit PCM, or by loading the audio into a program that is 24bit capable.

Finally, to transfer a sound, we can click the Transfer to PC button (or “Transfer to Mac” on
MacOSX) which will start a transfer of

●

the selected tracks

●

to the selected project directory

●

from the indicated starting point to the indicated endpoint

●

in the given sample rate and format.

In rare cases it is possible that you try to export a chunk of audio that is bigger than the
limitations of the audio format that it is being exported to. For instance, a live recording of
over four hours and a half of audio will probably be bigger than the maximum size allowed
for a WAV file. If we try to transfer such a file, HD24connect will ask us:

Under normal circumstances we will probably want to say Yes. In this case HD24connect
will automatically split up the audio into chunks that are small enough to result in valid
files. Should we be sure that nonsplitted files can still be read by our audio program (for
instance, by loading them as raw files), we can choose No to export as a single big chunk
anyway. Alternatively we can cancel the transfer and first set a few locate points manually,
as this allows us to use audio preview to set the split points at more suitable locations than
the automatic splitter can.

Transport Controls and Audio Preview
The bottom left of the Transfer Area contains transport controls. These are modeled after the
Little Remote Control (LRC) of the HD24 ADAT recorder and perform pretty much all the
same functions. The buttons visible on the transport control area are:

From left to right, the name and function of each of the buttons is:

●

Set Locate
After clicking Set Locate, it is possible to set the Loop Start and Loop End locate
points (Locate point 1 and 2, respectively). This is done by following clicking Set
Locate by clicking either the Loop Start/Loop End button marked by the Loop
bracket (see image above).

●

Toggle Loop mode
When enabled, playback will end at the Loop End locate point (Locate point 2) and
resume at the Loop Start locate point (Locate point 1). This is mostly useful when
streaming audio directly from disk.

●

Return to Zero
Returns the song cursor to the beginning of the song.

●

Loop start
Resets the song cursor to Locate point 1 (or sets Locate point 1 when Set Locate is
pressed)

●

Rewind
Moves the song cursor backwards by 5 seconds, if possible

●

Stop
Stops audio playback. In addition, this will initialize transport control and redetect
what audio playback mechanism is available. Under Linux, this is useful to switch
between Portaudio and Jack without restarting the application.

●

Fast Forward
Moves the song cursor forwards by 5 seconds, if possible

●

Loop End
Sets the song cursor to Locate point 2 (or sets Locate point 2 when Set Locate is
pressed). Most useful when transport is stopped.

During audio preview, the track selection checkboxes in the Transfer area double as Solo
buttons of a mixer. This means that when all or none of them are selected, all tracks are
audible; in any other case, only the selected tracks will be auditioned. This only applies to
the builtin mono audio preview of HD24connect (such as on Windows and Mac); Multi
track playback through the Jack Audio Connection Kit under Linux is unaffected by the
track selection.
During audio preview, it is possible to switch songs. However any locate points set in
memory before the switch will be lost.

HD24 Drive recovery
Introduction
In HD24 ADAT recorder operation, a few situations can occur that may cause data loss
which can not necessarily be blamed on the recorder itself power loss, user error, drive
failure, and so on. In most cases, the drive itself is not physically damaged – it merely is left
in a state that doesn't allow us to get to the audio anymore without the help of some
specialized tools.
HD24connect is champion of userfriendly drive recovery  for the first time ever, a
specialized tool is available that is so userfriendly that it enables normal users to perform
their own drive recoveries. In the following chapters, we will discuss how. Drive recovery
can be a very deeply technical subject. Because of this, the author will attempt to explain
things simple enough to be understood by the average person.
A few words about drive layout
Like all file systems, the HD24 drive consists of a system area and a data area. The data area
contains data, which for the HD24 recorder means audio; the system area (which we will
also call the drive header) contains information about how and where on disk that audio is
stored. Important parts of the system area are the superblock (which like most file systems
contains information about the drive parameters), the project list and the song list.
Although audio data itself is not immune to trouble, little can go wrong with its structure.
Because of this, when the drive is left in an inconsistent state, this will usually mean an
inconsistency in the structure of the system area (or drive header). If this is the case, by
restoring the consistency of the drive header, the drive will be readable again.
Types of recovery
There are different levels of performing a recovery. This manual will focus on readonly
recovery, which means we will limit ourselves to reading audio data from disk. By
performing a recovery as readonly process, we are safe from doing any more damage.

If we wish to create a recovered disk which is readable by a HD24 recorder, after
transferring the audio to computer we can use the HD24 recorder itself to write the
recovered audio to a new disk (or even format the old one and transfer the data there) by
using the builtin FTP transfer capability of the HD24 recorder.
For the most common types of recovery, the recovery procedure is similar. Now that we have
covered the basics, let us examine this general recovery procedure.

General recovery procedure
Assuming you have properly installed HD24tools, there are only a few steps that need to be
performed to perform a readonly recovery:

●

First of all, DO NOT use the drive for recording before recovery is complete.

●

Connect the corrupt ADAT HD24 drive to your system.

●

Next, start up HD24connect.

●

It is possible that the drive is not properly detected, in which case HD24connect will
show the following error message:

●

●

●

If this is the case, you need to manually select the ADAT HD24 drive with menu
choice File > Recovery > Select device... which will pop up a
dialog allowing you to choose between drives on your system. The device names in
the dialog below may differ slightly from your system.

If you don't know which device is the ADAT HD24 drive, do not worry. This is in
fact the tricky part. Typically the 'correct' device is the device which is listed only
when the ADAT HD24 drive is connected to your system. By running HD24connect
once without the ADAT HD24 drive connected, and once with the ADAT HD24 drive
connected, you should be able to spot which device to use. If you are still not sure,
you can just try the different devices one by one; as we are performing a readonly
recovery, this should be perfectly safe. In most cases, the first device listed is the
system drive of your computer it is usually unlikely that this is your ADAT HD24
drive.
Normally you only need to manually select a device because HD24connect didn't
manage to autodetect the drive. Because of this, drive selection is usually followed
by a popup dialog informing that the device doesn't look like a valid ADAT drive:

If you are reasonably sure that in fact you have chosen the correct drive, click Yes.
HD24connect will attempt to use its own virtual superblock to read the drive.

●

HD24connect will now ask you the following question:

Only when you accidentally initialized a noncorrupt HD24 drive, it will be enough
to click No. In any other case, or when unsure, click Yes.

●

Now it is time to select a header file. If the drive was automatically detected properly,
you will need to choose menu option
File -> Recovery -> Load Headerfile...

●

Now you can browse for a header file that matches your disaster scenario, after which
you will be able to transfer audio from disk to your computer. For likely disaster
scenarios, read the following chapters.

Disaster scenarios
Now that we are up to speed about drive layout and types of recovery, we can explore some
disaster scenarios along with their solutions.

Power loss during a live recording
This is probably the most common disaster scenario to occur in the HD24 scene. A recorder
is taken on location to a live recording session, where a power loss occurs either because
the power fails, or a power chord is pulled out, or because somebody accidentally hits the off
switch.
What happens during a power loss?
While the HD24 recorder is recording, it is only writing audio data to the data area of the
disk. The length of a song or recording is not written to the system area, because during
recording there is no time to update that information; also, the final size of the song is only
known when you press the STOP button of the recorder. As a result, when a power loss
occurs, the system area is not updated, leaving the disk in an inconsistent state, most likely
with the song length set to 0 and no information known about where the audio is stored on
disk.
How can you prepare to minimize the damage in case of a power loss?
There are a few things you can do to help reduce the chance of data loss when power fails.
1. Ideally, get a UPS (Uninterruptible Power Supply). In case of a power loss, this will
provide the HD24 recorder with backup power and the problem does not occur.
2. If possible, prepare your drive by recording silence to a song as long as you expect
the live recording to last. As information about where the audio is recorded to is
already known before recording, the disk will not be corrupted in case of a power
loss.
3. If the previous measures are too much trouble, at least quickformat your drive before
recording. This makes it easier to predict where the audio will and up on disk.
4. Do not record anything on your drive between power loss and recovery!
How can you recover audio from a drive that suffered a power loss?
Follow the general recovery procedure using the longliverec header file. Note: At this
point this will allow you to recover 24track and 16track recordings only. The header file is
limited to sample rates of 44100 and 48000 Hz.

Accidentally initialized the drive on the computer
This is a mistake that you will probably make only once, and most likely it will be the first
time you connect an ADAT HD24 drive to your computer. The computer will not be able to
read this drive, and because of this assume that it is an invalid or unformatted drive. Because
of this, it is possible that it will ask you a question along the lines of “The drive is not
initialized, do you wish to initialize it?” or “The drive is not formatted, format it?”. When
we answer Yes, the drive will no longer be readable by the HD24 recorder.
What happens if the computer initializes the drive?
When the computer 'initializes' the drive, it will overwrite the first data block of the drive
(commonly called Master Boot Record or Superblock) with a superblock that is recognized
by the computer. However, this will wipe out the signature by which the HD24 recorder and
any HD24 related software recognize the drive as ADAT HD24 drive. Fortunately, this
problem is relatively easy to resolve, for two reasons:

●

The HD24 recorder keeps a backup of the original superblock elsewhere on disk;

●

HD24connect is able to use its own virtual superblock with HD24 disks.

How can you prevent yourself from accidentally initializing the drive?
There is not much more you can do except being aware that the computer does not
understand ADAT HD24 drives. Don't worry you will quickly learn not to make this
mistake very often.
How can you recover audio from an accidentally initialized drive?
Use the general recovery procedure; after manually selecting the drive, do not load a header
file. This will cause HD24connect to use its own virtual superblock.

Quickformatted the (wrong) drive on the HD24 recorder
To help you prevent mistakes, the HD24 recorder will require you to confirm up to three
times that you really wish to quickformat a drive. Yet, accidentally quickformatting a drive
is more common than you would expect. One of the reasons is that it is not always entirely
clear which drive is being formatted.
What happens if the HD24 recorder quickformats a drive?
Fortunately, when the HD24 recorder quickformats a drive, all it does is reset the project
lists and drive usage information. The audio itself is still there; and in fact, all song
information still exists on disk as well. This includes the allocation information which
specifies where the audio resides on disk.
How can you prevent yourself from accidentally quickformatting the (wrong) drive?
Making sure that the HD24 recorder only contains one drive when quickformatting could
help. Other than that, by asking for confirmation three times the HD24 recorder already
does pretty much everything possible to prevent this situation.
How can you recover audio from an accidentally quickformatted drive?
Use the general recovery procedure with the unquickformat header file. This will
attempt to create a single virtual project with all songs in it. As any project is limited to 99
songs, the total number of songs that can be recovered is 99.

'Invalid Format'/'Corrupt Super Block' for no obvious reason
This is probably the hairiest disaster scenario of them all, because the cause is not entirely
clear. Possible causes include excessive vibration of the unit during recording; a bad contact;
or perhaps a bug in the software. Typically, this problem occurs during longer recordings.
During recording everything seems fine, yet after the recording the HD24 recorder suddenly
claims 'Invalid Format' and the Fireport software claims 'Corrupt Super Block', rendering
the drive unreadable.
Also, when manually selecting the drive with HD24connect and NOT loading a header file,
the name last recorded project may appear damaged (every other character in the name is
messed up).
What happened?
It is still not entirely clear what causes this condition. For some reason, during recording,
from a certain point on something went wrong in writing the data to disk. Every other byte
of data written to disk was damaged from that point on. As the song info, superblock and
project info are updated, these too are damaged. The last part of the audio of the last song
that you recorded may also be damaged. It is likely that some audio can not be recovered
because of this.
How can you prevent this situation?
As it is not entirely clear yet what causes this situation, not a lot can be said about how to
prevent it. However, here are some steps that may help:

●

●

●

Typically this condition only occurs during longer recordings. This suggests that
keeping your recordings short will help prevent this situation.
If needed, prepare a disk with several songs so that during breaks you can easily start
recording to a new song. Once a song is recorded, its audio will not be damaged.
Bring several disks should one disk give 'Invalid format' while switching songs, you
will have another one to continue the session.

How can you recover audio from this situation?
In this scenario, you will have the best chance of recovery by first attempting the general
recovery procedure without header file; then with the unquickformat header file, and
finally using the longliverec header file. Most likely, part of the audio of the last
recorded song is damaged. It is very unlikely that any damaged audio can be restored.

Other disasters
Although most disaster scenarios are comparable with previously described scenarios, there
may be situations where following the general recovery procedure is not enough. You may
have projects with different sample rates or number of tracks than offered by the
longliverec header, or you may need to recover more than the 99 songs offered by the
unquickformat header, or you have a specific scenario which is not covered or
solveable by any of the previous scenarios.
In such cases, you can try to create a header file and send it to us for diagnostic purposes.
This can be done by menu option
File > Recovery > Create header file...
This will allow the author to take a look at the disk structure, and possibly create a custom
header which will allow you to read your disk. A fee may be charged for creating a custom
header file. However, it may not always be possible to perform a recovery based on a header
file only. Specifically, when it is necessary to reconstruct where and how the audio is stored
on disk, the audio itself (and thus the disk) will be needed to allow for a recovery.
If the disk is required for recovery, or if this whole thing of header files and readonly
recoveries is too technical for you, you can send over your drive for recovery. An advance is
requested to cover sending costs and diagnosis. Additionally, a (reasonable) fee is charged
when recovery is successful. In advance, please contact the author by email for pricing and
contact info.

Using HD24hexview
Introduction
HD24hexview is a commandline ondisk hex viewer and editor which has some features
that help to make it suitable for working with HD24 drives. However it can also be used to
view and edit sectors of other drives.
If you are not familiar with hex editors and drive editors, you will probably have little use for
a program like HD24hexview, and you will be able to safely ignore it. However if you have a
technical background and you wish to study the contents of your HD24 drive, HD24hexview
is the tool of choice.

Command line options
dev=<device file>
Will allow you to use a device other than the first detected HD24 device.
Additionally, this will allow you to use image files as device.
force
Allows you to use a device, even if it isn't recognized as valid HD24 device
header=<header file>
Allows you to load a header file.
expert
Starts hd24hexview in readwrite mode instead of readonly mode.

Inside HD24hexview
While using hd24hexview, the most important command to remember is ? because it will
show you the help page of the program. You can exit the program by typing q followed by
enter. The displayed command list should be pretty much selfexplanatory. Feel free to
contact the author if you feel the options need more explanation.

